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ORDERING ANIMAP AND SITEFINDER
AniMap and SiteFinder are now available on CD ROM. Included are the AniMap County 
Boundary maps for 48 states (no Alaska or Hawaii), the SiteFinder U.S. Place Name Database
containing nearly 250,000 cities, towns and other places of interest both current and historical,
and the SiteFinder Cemetery File containing over 100,000 cemeteries throughout the United 
States.

The AniMap/SiteFinder CD ROM is available from:

THE GOLD BUG, POST OFFICE BOX 588, ALAMO, CA 94507

Visa or Mastercard orders may be submitted by phone (510) 838-6277 or our toll-free number
(888) 653-6277.    E-Mail to goldbug@compuserve.com 

Price of the AniMap/SiteFinder CD ROM is $79.00+4.50 shipping & handling. California 
residents please add sales tax.



Displaying The Maps
The maps may be viewed either in full-screen mode, or you may re-size in the usual Windows
fashion (click the double triangle in the upper right corner and drag the borders to where you 
want them). You may then open AniMap Plus again and display other maps on the screen, 
either the same or different states.

Several viewing options are controlled by buttons on the screen:

NEXT displays the next map in chronological order.

BACK reverts to the previous map.

RUN displays the maps in sequence something like a motion picture. Clicking on the "C" box
will skip any years for which there were no changes. FWD runs the display in chronological 
order, REV runs in reverse chronological order.

1, 2, 3, and Q control the Run speed. The numbers indicate the number of seconds a map is 
displayed before moving on to the next. Q (for Quick) moves through the display very 
rapidly. Clicking on the circular (Radio) buttons will select these.

FLASH will alternately display two consecutive maps for easy comparison. Clicking on the 
"C" box before selecting flash will alternate the display between the selected map and the 
modern map

STOP will halt either the RUN or FLASH operation. All the other controls are inoperative 
until you have stopped these functions.

RESTART returns you to the first map in the series for that state.



County Codes
Limited space makes it necessary to use abbreviations for county names on the maps. The 
County Codes box provides a list of these abbreviations. This is only a list; clicking the 
mouse on a county name has no effect.



Markers
 
MARKERS: To mark reference points on a map, you have a selection 
of 13 different designs which are color-selectable. Up to 50 of these 
markers may be placed on any one map (all alike or mixed). Selecting 
MARKERS from the Options Menu (K is the shortcut key for this) will 
bring up a box showing the designs. Select one by clicking on the 
circular button (Radio button) below it. Clicking the buttons in the Color Box will cycle 
through the available colors. When you have made your selection, click 
OK.

To set the markers, use the right mouse button to activate the marker 
cursor. Move the marker to where you want it, then click the left mouse 
button. You can then continue placing markers following the same 
process or return to the Marker Box to choose another design or color.

An alternative which allows more control over placement of the 
markers is to press the INSERT key to activate the marker cursor, 
move the marker using the Arrow Keys, then press INSERT again to 
place the marker.

If you are not using a mouse, the marker process may be started by pressing the INSERT key, 
moving the cursor with the Arrow Keys, then pressing INSERT again to place the marker.

To remove a single marker, point to it with the cursor and click the left 
mouse button again. If you want to remove all the markers, bring up the 
Marker Box and click on ERASE ALL. 

If you want to save a set of markers you have on the screen, bring up 
the marker box and click on SAVE. RETRIEVE will bring them back at 
any time. Repeated clicking on RETRIEVE will cycle through and show 
any additional marker sets you have saved for that state.

CLEAR MEMORY will erase the marker set you presently have 
displayed on the screen. There is a limit of 10 marker sets that can be 
saved, either for one state or all states in combination. If all the marker 
memory slots are filled, SAVE will not appear in the box and you will 
see a list of the states for which markers are saved to help you find 
saved sets and possibly clear some space.

[Note for advanced users: The file in which the marker sets are saved 
is ANIMAP.DAT. You can create a library of marker sets by saving a 
copies of this file under other names, then bringing them back as 
ANIMAP.DAT. Do not simply rename ANIMAP.DAT; this file must be 
present for the program to run correctly.]

Loading up the screen with markers may slow the RUN operation down 



a little, but not seriously on most systems.



Creating Your Own Overlays
Choose the map you want to use as the base for your overlay. 
You may want to place some markers on this map to use as 
reference points when you make the overlay. Select a color for 
your markers that is not already being used on the base map 
(this will make it easier to erase them later if you wish). When 
the map is ready, select EXPORT from the File Menu, then 
EXPORT TO PAINTBRUSH from the dialog box.

A transparent overlay, which is probably what you will use 
most, will display only what you have done in black. It is best, 
though, to start making the overlay using a color that is not on 
the map you have exported. Dark Brown is a good choice 
because it is easy to see your work as you go along.

Draw what you want to put in your overlay. You may want to do 
things like connecting the markers you placed to show a trail or 
migration route. You can use the Text Tool to add in names, 
titles, etc. You can fill in the boundaries of a county with color 
using the Roller Tool. There are a great many possibilities to 
explore.

For a clean-looking transparent overlay, you should eliminate 
the base map, and possibly the markers if you don't want them 
to be part of the overlay. There is a small possible pitfall here... 
before you start changing colors, switch to any tool in the 
toolbox other than the one you have just used. For instance, if 
you have just used the Text Tool, then change colors, the text 
you placed will change to the new color. Switching to another 
tool will avoid this.

For this example, we are assuming that you have done your 
overlay in dark brown and want to eliminate everything else. 
First, select Black as the foreground color and white as the 
background color. The left mouse button selects foreground, 
right mouse button selects the background color. Your 
selections appear in the box to the left of the color palette. 
Double click on the Color Eraser tool (this is the eraser icon on 
the left). This should remove all the black in your viewing area. 
Scroll across and down to repeat this process for the entire 
map. Next, select Red as the foreground color and repeat the 
process to remove all the red from the map. Do the same for 
other colors until you are left with just the brown overlay. Select 
VIEW PICTURE from the View Menu to be sure you have not 
missed anything.

Now you need to change your Brown overlay to Black. Select 



Brown as your foreground color and Black as the background 
color and double click on the Color Eraser. Once again, you will 
need to scroll around the screen and use VIEW PICTURE to be 
sure you have changed everything. Your overlay is now 
complete and you are ready to save it.

From the Edit Menu, select SAVE AS... (not just SAVE). Using 
the correct name is important since AniMap Plus looks for a file 
with a specific name and will ignore anything else. The state 
abbreviation will be the first two characters of the title which 
appears at the top of your Paintbrush screen. For instance, it 
may be AL1876XP.BMP indicating you are working with an 
1876 map of Alabama. The first overlay for Alabama would be 
titled ALOVLAY1.BMP, the second ALOVLAY2.BMP, and so 
on. (See Filename Conventions)

Be careful about overwriting files that already exist, unless this 
is what you want to do. Paintbrush will warn you if a file with the 
same name already exists which gives you the opportunity to 
change the name before you save.

You can now exit Paintbrush and you will be returned to 
AniMap. Follow the instructions for displaying overlays to view 
your work. 

Also see Overlays.



Map Feature Definitions
See Legend to view these features on sample maps.      

 UNORGANIZED COUNTIES.    These are counties whose 
boundaries have been established by the legislature, but do not have 
an established government. Usually, they are attached to an adjacent 
or nearby county which takes care of government services. These are 
indicated on the maps.

          NON-COUNTY AREAS. Especially in earlier times, there were 
areas within a state which were not assigned to any county. These are 
shown on the maps with a unique shading pattern.

          EXTRA-TERRITORIAL COUNTIES. In some cases, states 
established counties that were outside the accepted state boundaries, 
sometimes for the purpose of laying claim to these areas. These are 
indicated with green boundary lines on the maps.

          INDEPENDENT CITIES. Virginia has established a number of 
"Independent Cities" which are not part of any county. These are shown 
using a special color coding on the maps.



Exporting Maps
When you have a map on the screen, you can choose to export it using 
this option. It will be placed in a bitmap (.bmp) file which can be used in    
virtually any Windows application. The exported map will have a 
filename like "AL1825XP.BMP". The first two letters indicate the state 
(Alabama), the numbers are the year, XP indicates that it is an 
exported map. 

The county code list may also be exported for use in your word 
processing software. The exported file for the above map, for instance, 
would be AL1825XP.TXT.

A third Export option lets you take the map directly into Windows 
Paintbrush for immediate editing. After editing an exported map, it is 
suggested that you give it a new name. AniMap will not permit a 
second export to the same filename.

Also see Filename Conventions.

                            Creating Overlays



Filename Conventions
FILE NAME CONVENTIONS

State abbreviations have been used in the file names which mostly 
conform to the postal abbreviations for those states. The exceptions 
are MA which includes Massachusetts, Rhode Island and Connecticut, 
MD which includes Maryland and Delaware, NH which includes New 
Hampshire and Vermont and VW which is Virginia and West Virginia.

Alabama      AL                                      Arizona      AZ                                                    Arkansas      AR
California      CA                                  Colorado      CO                                              Connecticut      MA
Delaware      MD                                Florida      FL                                                        Georgia      GA    
Idaho      ID                                                Illinois      IL                                                              Indiana      
IN        
Iowa    IA                                                    Kansas      KS                                                      Kentucky    KY 

Louisiana      LA                                  Maine      ME                                                          Maryland      MD

Massachusetts      MA                Michigan      MI                                                    Minnesota      MN      
Mississippi      MS                            Missouri      MO                                                  Montana      MT       

Nebraska      NE                                Nevada      NV                                                      New Hampshire     
NH    
New Jersey      NJ                            New Mexico      NM                                    New York      NY             

North Carolina      NC                North Dakota      ND                                    Ohio      OH                         

Oklahoma      OK                            Oregon      OR                                                          Pennsylvania      
PA              
Rhode Island    MA                      South Carolina      SC                                    South Dakota    SD         

Tennessee    TN                                  Texas      TX                                                            Utah      UT            

Vermont    NH                                      Virginia      VW                                                  Washington      WA

West Virginia      VW                    Wisconsin      WI                                              Wyoming      WY

The exported state files will have names like MAPZxx.ZP2. "xx" indicates the 
state abbreviation. So, MAPZAL.ZP2 would be the map file for 
Alabama.

Overlay files will be named xxOVLAY#.BMP. "xx", again, is the state 
abbreviation and "#" being a sequential numbering between 1 and 9. 
The first overlay for Alabama, for example, would be ALOVLAY1.BMP. 
Overlay names must be correct for the program to detect them. 
Numbers must be consecutive, beginning with 1 for AniMap to detect 
all the overlays.





Latitude-Longitude Tracking
SHOW LAT-LONG: This feature will allow you to place your markers 
very accurately on any point where the latitude and longitude are 
known. Selecting this option will place a large button reading "Latitude-
Longitude" on the screen. This button can be moved to any position. 

Activating this feature is the same procedure you use to place a 
marker. Click the right mouse button to start it. The button will now 
show you the latitude and longitude for the present cursor position and 
will change as you move it. The left mouse button will drop the marker 
at the desired latitude and longitude.

Since the display changes so rapidly, you may want to use the 
keyboard to fine tune the location. Get the approximate location with 
the mouse then use the right, left, up and down arrows to place it 
exactly. You can drop the marker by using the Insert key on your 
keyboard to avoid jiggling the mouse and changing the position.

Once you move the cursor, the button will show the new latitude and 
longitude so you can place additional markers.

Latitude and longitude coordinates are available from a number of sources including 
geographic servers on the Internet, some atlases and gazetteers, and from SiteFinder 
databases.



Mileage Measuring

MEASURE MODE is a very useful feature in cases where you are 
given a location description such as "47 miles NW of Baltimore". The 
anchor point (in this case, Baltimore) is usually a well-known place for 
which you can find the latitude and longitude coordinates. Having 
placed that using AniMap's latitude-longitude tracking, mileage mode 
makes it easy to place the location of the second place on the map.

Measure Mode is activated either from the Options Menu of by using 
the hot key "M". The mileage button will appear on the screen and can 
be re-positioned in the same way as the Latitude-Longitude button. 
Clicking the right mouse button will bring up one of two different cursors 
depending on whether or not you have any markers already on the 
screen. If you do not have any markers, the cursor will appear as the 
"X" mark which you can move into the desired position and place by 
clicking the left mouse button. When the marker is placed, it will appear 
as the "anchor on marker" illustrated above.

If there is at least one marker on the screen, the cursor will be the 
anchor ring which is intended to be placed over an existing marker to 
flag it as the anchor. You will not be able to drop it at any place other 
than over an existing marker. It need only be close to being centered 
over the marker and will lock on to the precise position when dropped.

Note that the anchor marker is a ring with four arrows pointing outward. 
The destination marker is almost identical, but with the four arrows 
pointing inward.

The same logic applies to the setting of a destination marker. If there is an anchor marker on 
the screen, the right mouse button changes the cursor to the destination marker pattern. If 
there are no other markers on the screen, a new marker can be placed, and will be flagged 
with the destination ring. If there are other markers on the screen, the destination cursor must 
be placed over one of them to flag it as the destination. The Mileage Button will give you a 
continuous reading of the number of 
miles between the anchor and the present cursor position. The 
destination marker is also dropped by clicking the left mouse button.

As with Latitude-Longitude tracking, you can use the arrow keys to 
move the cursor and the INSERT key to place a marker.

Erasing Markers: Clicking the left button over the destination marker 
will remove the destination ring, but will leave the marker in place. 
Another click will remove the marker. Clicking on the anchor marker 
will remove both the anchor and destination rings.



Overlays
Selecting Overlay from menu bar (Y is a shortcut key to do this) will 
bring up a box with a number of choices. Please note that RUN, NEXT 
and BACK may not operate properly with an overlay on the screen:

Modern Map: This will overlay a map of the present boundaries over 
any other map you are displaying on the screen.

Save Map: If you want to overlay a map other than the modern map on 
another, you can use this option to save the map you want to use as an 
overlay. Then you can bring up the map you want to have below the 
overlay and select USE SAVED MAP to display it.

Latitude-Longitude: This option will overlay a grid showing latitude and 
longitude coordinates over the map you have displayed.

Import Overlay: AniMap Plus will allow you to import overlays in a 
variety of colors on any of the maps generated by the program. You 
have the choice of using overlays which we will have available in the 
future or creating your own (or, of course, some of each). Only one 
overlay at a time can be used. When there is an overlay available, the 
Overlay Dialog Box will include an item for IMPORT OVERLAY. If 
more than one overlay is available, there will be a numbered button. 
Clicking on this button will cycle through the available overlays. There 
is a limit of    9 overlays that may be used for each state or the U.S. 
map. (See Appendix 2 to create your own overlays)

OPAQUE MODE will overlay a map or grid which will completely cover 
the underlying map. Color options are not available in this mode.

TRANSPARENT MODE will use a color-selectable overlay through 
which your map may be viewed. Clicking the buttons in the color box 
repeatedly will cycle through the available colors.

Also see Create Overlays.



Printing Maps

This option will print the map on the screen to whatever default printer 
you have set up for Windows. You may need to check Print Manager 
(in your Main Group) to be sure your have the correct printer specified 
as the default printer. AniMap provides a Printer Setup box to change the settings for your 
default printer.

Print Manager allows you to specify whether you want Portrait or 
Landscape format. Printing in Portrait will produce a small map using 
only the top half of an 8.5 by 11 page. Landscape will give you a full 
page, about the same size as the map on your screen.

If your printer provides selections for Vector or Raster graphics, be sure 
it is set for Raster mode. To find this selection, use the Printer Setup 
box and select "Setup", and then "Options".

Just the map will be printed; not the control buttons. You also have the 
option of printing the list of counties with their abbreviations for any 
given year. 

A third printing option will allow you to print the map and the county 
code list on the same page (if space permits). States with many 
counties, Texas for example, will run over to a second page. AniMap 
automatically sets your printer in Portrait Mode if you select this option.

NOTE: Some printers may not work correctly    using this demo version of AniMap Plus. If 
you have a problem with printing from the File Menu, you may use Export and the Export to 
Paintbrush option, then print from the Paintbrush program.



Technical Assistance
If you have problems with AniMap Plus and need assisance, call us at 
510-838-MAPS between 9AM and 6PM Pacific Time on weekdays. 
Please leave a message if there is no answer (we have a very small 
staff). If we are unavailable for any extended period, we will leave an 
alternate number on the answering machine.

Online help is also available by addressing e-mail to:

Internet:                            GOLDBUG@AOL.COM
America Online:      GOLD BUG
CompuServe:              70303,2363



What's New
The AniMap County Boundary Historical Atlas was first introduced in 1994 for the 
purpose of illustrating the changes in the county boundaries for each state in map form. All 
changes are included from colonial times up to the present. AniMap Plus is an enhanced 
version of that atlas which includes many enhancements.

AniMap Plus also includes a set of maps of the United States (except Alaska and Hawaii) 
from 1776 to the present showing the development of states and territories. 

Among the new features in this version, you have the ability to place 
markers on the map for places where the latitude-longitude coordinates 
are known, or places which are a known distance from another point using Mileage 
Mode.Your markers are available in a variety of designs and colors, and a set of markers may 
be saved for future use.

Overlays are available for latitude and longitude plus the ability to save 
any map to use as an overlay for another. You also have the ability to 
create overlays of your own design.

Windows may be re-sized, and we have added the capability to open 
multiple copies of AniMap so that more than one map may be viewed 
at one time.

These instructions assume that you are using a mouse to operate the 
program. All functions can be done with the keyboard, and those 
instructions will follow later. Unless the instructions specify the right 
mouse button, assume that clicking is to be done with the left button.

If    you are an experienced Windows user, some of this material may 
seem redundant. We have included some very elementary items 
because many of our users have minimal experience with computers in 
general and Windows in particular.

This atlas is the product of many years of research and we believe you 
will find it to be the best resource of its kind in any form.



Sample United States Map



See Definitions for additional explanations.



Map Selection
When you first activate AniMap Plus, a Welcome Screen apprears with a Pick State List. 
Double-clicking the mouse on the state of your choice will bring up the earliest map for the 
state you selected.

To change to another state, click the mouse on "Menu Bar" at the top of the screen, then select
File and Open. This unusual menu bar operation makes it possible to provide slightly larger 
maps.



The Anchor point is the "from" location in Measure Mode. The destination 
marker is the "to" location.



Plotting Locations      
Hot Key: P

AniMap is linked to a database containing the names, counties and locations for more than 
230,000 places (past and present) in the United States. These locations may be accurately 
plotted on the state maps in AniMap.[This function is not presently available on the full U.S. 
map.]

To use this function, first select SiteFinder from the Options Menu in AniMap. This will 
bring you to the SiteFinder Welcome Screen where you will have choice of selecting a region 
to search, or the full database. The regional files are provided to allow    faster searching.

SiteFinder includes Search and GoTo functions to help you locate places quickly. When you 
have found a place you want to plot on a map, highlight it with the left mouse button and 
select Pluck from the Options Menu. You may pluck up to 20 items. More detailed 
instructions are contained in the SiteFinder Help File.

When you have finished with the plucking operation, exit SiteFinder. Selecting Plot from the 
AniMap Options Menu will display a list of the places you have plotted:

            

To get the Plot List, you must be displaying one of the states for which you have plucked an 
item. Double-clicking with the left mouse buttons on one of the items on the Plot List will 
display the location on your map.

                                                                
The place-name label may be moved to another position by holding down the left mouse button 
and dragging it. The arrows (>>) may be removed by a single left-mouse click at the opposite 
end of the label. A second mouse click will place the arrows at the other end of the label.
Accessing the Help File in SiteFinder will provide detailed instructions on all the functions in 
that program.



ORDERING ANIMAP PLUS AND SITEFINDER
AniMap Plus and SiteFinder are now available on a single CD ROM. Included are the 
AniMap County Boundary maps for 48 states (no Alaska or Hawaii), the SiteFinder U.S. 
Place Name Database containing nearly 250,000 cities, towns and other places of interest both
current and historical, and the SiteFinder Cemetery File containing over 100,000 cemeteries 
throughout the United States.

The AniMap/SiteFinder CD ROM is available for $79.00+4.50 shipping & handling from:

THE GOLD BUG, P.O. BOX 588, ALAMO, CA 94507

Credit card orders may be submitted by phone (510) 838-6277 or our toll-free number (888) 
653-6277.    E-Mail to goldbug@compuserve.com.






